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Introduction

This document is a step-by-step guide on how to set up and use the Fiery proServer with your EFI printer.

Connecting and starting the Fiery proServer

All required cables and components are provided in the Fiery proServer shipping box.
Keep the following guidelines in mind when making connections:

• Be sure to use the appropriate power cable for your regional outlet type.

• By factory default, the upper Ethernet port is configured for DHCP, which means that it can dynamically request
IP addresses. Use the upper Ethernet port to connect the Fiery proServer to your company network.

• The lower Ethernet port is also configured for DHCP and can be used to connect to the inkjet printer, assuming
that both the Fiery proServer and inkjet printer are on the company network.

Note: The procedures for connecting the Fiery proServer Premium and Fiery proServer SE are different. See 
Connecting the network and the printer to the Fiery proServer Premium on page 6 and Connecting the network
and the printer to the Fiery proServer SE on page 5.

Connecting the network and the printer to the Fiery proServer SE

The Fiery proServer SE has two network connectors on the back panel. The upper network connector is used to
connect the Fiery proServer SE to your network. The lower network connector is used to connect the Fiery
proServer SE to the printer.
• Use the graphic to help you in connecting the Fiery proServer SE to the network and the printer.
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1 USB 2.0 ports

2 Monitor port

3 USB 2.0 ports

4 USB 3.0 ports

5 Power port

6 Network connection

7 Printer connection

8 Power switch

Connecting the network and the printer to the Fiery proServer Premium

The Fiery proServer Premium has two network connectors on the back panel. The upper network connector is used
to connect the Fiery proServer Premium to your network. The lower network connector is used to connect the Fiery
proServer Premium to the printer.
1 Insert the network cable into the upper Ethernet connector on the back panel of the Fiery proServer Premium.

2 Insert the printer cable into the lower Ethernet connector on the back panel of the Fiery proServer Premium.
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1 Power connector

2 Power switch

3 Type A USB2.0 ports

4 Type A USB3.0 ports

5 DVI port (monitor)

6 Network port

7 Command interface port (for straight-through Ethernet cable)

Start the Fiery proServer

The procedure below appliees to both the Fiery proServer Premium and Fiery proServer SE.

1 Move the power switch on the back panel to the ON ( | ) position.

2 Power on the Fiery proServer using the power button on the side of the display panel. Press once and release the
button to power on the system. The power supply automatically senses the correct voltage.

3 Allow startup to proceed without interruption. Do not press any buttons while the system is starting.
The Fiery proServer takes approximately two minutes to start up. Follow the on-screen instructions to complete
initialization of the Fiery proServer.

4 At the Admin login on the monitor, enter Fiery.1 in the password field, and then press Enter.
Type Fiery.1 exactly. The password is case-sensitive; for example, fiery.1 will not work.

Fiery proServer Quick Start Guide

Introduction

7



5 Do one of the following:

• If you need to change the language of the Fiery proServer from English, proceed to Setting the language on the
Fiery proServer on page 8.

• Activate the license for the Fiery XF server.

• Otherwise, proceed to Downloading documentation on page 9.

Setting the language on the Fiery proServer

You can change the language of the system.
When you first start the Fiery proServer, after logging in, you can setup the language. You can also change the
language later.

Note: The language change takes up to 15 minutes to complete. When the language change is in progress, it cannot
be aborted.
The language change is applied to the operating system and keyboard, Fiery Server Control, and the Fiery XF server.

1 In the Windows taskbar, start Fiery System Tools.

2 Select the language from the Language Setup drop-down menu.

3 Or click Change system language in the Fiery System Tools window, and select a language from Language Setup
drop-down menu.
If you change the language, you need to restart the system.

4 Click Restart.

The Fiery XF software also has its own language setting which overrides the language setting made for the Fiery
proServer. For more information, see the Changing the language of the Fiery XF software on page 8.

Changing the language of the Fiery XF software

You can change the language of Fiery XF software in Command WorkStation Preferences.
The Fiery proServer comes installed with Fiery XF software, which includes Command WorkStation.

1 In Command WorkStation, click Edit > Preferences.

2 Click Region.

3 Select a language.

4 Click OK.

5 Restart Command WorkStation.
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Downloading documentation

You can access and download all Fiery proServer documentation at any time.
The Installation Guide is provided printed in your accessory box and also online. The Quick Start Guide is provided
printed in English in your accessory box and also online. The Quick Start Guide in other languages is provided
online. All other documentation is provided online.
The Fiery proServer documentation set consists of the following:

• Installation Guide describes how to install the Fiery proServer and activate the Fiery XF license.

• Quick Start Guide is a step-by-step guide on how to set up and use the Fiery proServer with your EFI inkjet
printer.

• Upgrade Guide describes how to upgrade the Fiery XF software on your Fiery proServer from a previous version.

• User Guide describes how to keep the Fiery proServer in good working condition after initial installation and
setup.

1 Double-click the Adobe icon on the Fiery proServer desktop to open the Adobe website and download Adobe
Reader.
You need Adobe Reader in order to access the Fiery proServer documentation, which is provided in PDF format.

2 Open the web browser of your choice.

3 To download the Fiery proServer Installation Guide, Quick Start Guide, Upgrade Guide, or User Guide, go to 
help.efi.com.

4 As needed, click the links for your product version and language, and download the latest documentation.
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Setting up the software

The Fiery proServer ships with the Fiery XF server and Command WorkStation preinstalled.
You can install Command WorkStation on other computers and log on to the Fiery XF server that is installed on the
Fiery proServer.
To configure Command WorkStation, you must install media profiles for your printer, and configure media and
workflows. Each printer is initially configured with one generic media and one generic workflow.

Note: Command WorkStation can receive information about media consumption and ink consumption from EFI
printers that support bidirectional communication. For more information on setting up a bidirectional
communication, see Fiery Command WorkStation Help.

Activating the Fiery XF software license

On first time connection to Fiery XF software, you must activate the license.
Make sure you have your License Activation Code (LAC), which is shipped with your Fiery proServer. The LAC is
required to activate the software. Store your LAC so that it is available for future reference, in case of deactivation.
Select and copy it after or during activation and then paste it into a text document, store that on a network drectory,
or on a USB flash drive.
The Fiery XF software comes pre-installed with Command WorkStation on the Fiery proServer. Different
instructions will be provided, depending on whether the Fiery proServer is connected to the internet or not.

1 Start the Fiery proServer.

2 In the Fiery proServer Configuration window, click Activate software.

3 Select Activate if you have a LAC, and follow the on-screen instructions.

4 Click Migrate if you are upgrading from a legacy dongle-protected Fiery server and follow the on-screen
instructions.
The LAC will be downloaded from within the application during the migration workflow.

You can always check the status of licenses or manage licenses in Server Manager > Server > License/Contract.
To open the license activation browser after first-time setup, open Fiery Server Control from the Windows taskbar
and select Manage Licenses.
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Log on to server

You must log on to the Fiery XF server that is installed on Fiery proServer. When you have set up a connection to the
Fiery XF server, Command WorkStation automatically logs on to that server whenever you restart the computer.
Before you begin: Make sure that the Fiery XF server is running. The Fiery Server Control icon located in the taskbar
displays a white arrow on a green background when the server is running.
The software normally starts automatically after installation is completed. If Command WorkStation is not already
started, click Fiery Server Control, and then click the green icon with the white arrow in the top right corner of the
window.

1 In the Welcome screen, click the Add (+) button.

2 Select a Fiery XF server from the list, or type the server name or IP address. Then, click Add.

3 Select the admin user and type Fiery.1 as the password. Then, click Login.
These are the login credentials for the default administrator.

You can now download media profiles, and add your printer.

Install media profiles

Media profiles are required in order to print. You can download the latest media profiles through Fiery Server
Control.
Media profiles describe the color reproduction properties of the printer for a specific media. The color reproduction
properties are defined by the combination of media type, ink type, and print conditions.

1 In the taskbar: Right-click Fiery Server Control, and click Fiery Profiles Updater.
The Profile Update Service window opens.

2 Click Next.

3 Under Manufacturer/Model, click EFI VUTEk (Fiery XF 6.5+ linearization), EFI Matan or EFI Reggiani, and select
your printer model.

4 Under Media Profiles, select the media profiles that you want to install.

5 Click Download List (optional).
You can view the listed of selected media profiles. To add or remove media profiles from the list, click Add More
Profiles.

6 Click Download.

7 Click Finish.

8 Restart the Fiery server.
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Add printer

You must add a printer before you can import jobs, or restore a system backup. Your license determines which
printers are available for selection in the software.
1 Click Add Printer.

The New Printer dialog box opens.

2 Select EFI as the printer manufacturer.

3 Select a printer type.

4 Type a name for your printer (optional).
This is the name that is displayed in the software. By default, Command WorkStation displays the printer type.
You can overwrite the default name.

5 Add a description (optional).
For example, you can enter the printer location, or the type of media inserted in the printer.

6 Click Next.

7 Configure the printer connection in one of the ways below.

Note: The printer must be switched on. Otherwise it cannot be detected.

• EFI VUTEk, EFI Wide Format printers: Configure a network printer on page 12

• EFI VUTEk, EFI Matan and EFI Reggiani printers: Configure a print-to-file printer on page 13

Some EFI VUTEk printers can print through their IP address and can also output to file. Configure the printer to
print through its IP address if your printer supports bidirectional communication and you want Command
WorkStation to receive status messages from the printer. For more information on setting up a bidirectional
communication, see Fiery Command WorkStation Help.

8 Click Finish.
The Server Manager window opens.

You can now configure the software, or restore a system backup from Fiery proServer 6.5.

Configure a network printer

You can connect to a printer through its IP address.
1 Under Connection type, select Print via IP network, and type the printer’s IP address.

2 Select the type of TCP/IP protocol that your printer uses for data transfer.
Most printers support the RAW protocol and print to port 9100. The LPR protocol is normally reserved for Unix
systems or print servers with multiple interfaces. In most cases, you can leave the box blank. Refer to your printer
manual or ask your system administrator if you are unsure.
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Configure a print-to-file printer

You can define a naming format and select an export folder in which to save print files.
Print files from EFI VUTEk printers are saved in RTL and GIF format to the specified Export folder. The GIF files are
used to display a preview of the job on the VUTEk User Interface. You can open GIF files in any conventional
graphics program.
Print files from EFI Matan and EFI Reggiani printers are saved as separated TIFFs to the specified Export folder. If
you select an Export folder that resides in the network, you must type access rights to the folder.

1 Under Connection type, select File output.

2 Define the export path (optional).
Use the default export path, or click Choose and browse to a different folder.

3 Select a naming format for the print files.
The default naming format is job order_job name_job ID_tile number_page number_Date. You can define a
custom naming format that may also contain custom text, and any of the following variables:

Variable Description

%count Counter

%jobid Job ID

%t Tile number

%p Page number

%out Printer

%cm Color mode

%job Job name/nesting name

%res Resolution

%work Workflow

%date Date

%order Job order

Note: File names are easier to read if you add a separator, such as an underline or a hyphen, between two
variables.
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Configure the media

Command WorkStation uses media to define print options. Each new printer is initially configured with one generic
media.
Make sure you have installed appropriate media profiles.

1 In Server Manager: On the sidebar, click Printers, and select the printer. In the printer's tree view, select the
generic media. On the Media tab, expand the Media Configuration panel.
All the available calibration files for your printer are listed under Resulting calibration(s). If the list is empty, you
must download appropriate media profiles through Fiery Profile Updater.

2 Select an ink type, a media name, and other media settings.
The list of calibration files is filtered to display only those files that match the selected combination of media
settings.

3 On the Media tab, expand the Media Settings panel.

4 Select a media source: Roll media or sheet media.

5 Select a media format.
You can also define a custom media format. Custom media formats cannot be bigger than the printer's maximum
supported media size. Click the Add (+) button, and save your media format under a unique name.

6 On the Printer & Workflow Settings tab, expand the Special Settings panel.

7 Make the printer-specific settings that you want to incorporate into the media.

8 Click Save.

For more information on creating additional media, see Fiery Command WorkStation Help.

Configure the workflow

Command WorkStation uses workflows to define a default group of settings to your jobs. Each new printer is initially
configured with one generic workflow.
1 In Server Manager: On the sidebar, click Printers, and select the printer. In the printer's tree view. click the Add

(+) button next to Workflow.
The Workflow Templates window opens.

2 Under Type of Workflow, select Production.

3 Under Templates to Use, select an EFI Inkjet Solutions workflow template.
Each workflow template has been pre-configured for either standard or maximum print quality and with color
management settings that are typically used in either America or Europe. When you select a template, Command
WorkStation displays the recommended application for use and which standard icc profiles will be applied to jobs
that are processed in that workflow.

4 Click Load.
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5 Close Server Manager.

For more information on editing workflows, or creating new workflows, see Fiery Command WorkStation Help.
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Overview of the Command WorkStation user
interface

Command WorkStation consists of three program windows.

• Job Center is the start screen of Command WorkStation. Here, you can load jobs, and start printing.

• Job Editor is for editing jobs. Here, you can scale, and rotate jobs, manage spot colors, create tilings, make color
adjustments, and much more. Job settings override the default settings made for the workflow.

• Server Manager is where you create workflow presets, apply media presets, configure printers, and create users.
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Manage print files

You can manage your print files most efficiently by configuring folders which help to automate processes.
For job input, it is recommended that you configure a hot folder. A hot folder is a centrally located folder that is
routinely monitored by Command WorkStation. Jobs that are placed in the hot folder are loaded automatically into
Job Center for processing.
After job processing, Command WorkStation saves the print files to the following folders:

• EFI VUTEk printers connected through the IP network: Command WorkStation automatically transfers RTL
print files to the Import folder that is configured for the VUTEk printer software. This is the preferred method to
use.

• EFI VUTEk printers configured to print to file: Command WorkStation saves the RTL print files to the Export
folder. The easiest way to transfer print files to the printer's Import folder is to create a shortcut on the Fiery
proServer desktop.

Note:

EFI Matan and EFI Reggiani printers: You must copy the print files from the Export folder manually to the printer.

Configure hot folders

A hot folder enables users to copy print jobs to a centrally available folder for printing. Network access rights are
required to print through a hot folder.
A hot folder can be located on the same computer as the Fiery XF server or acessed through the network. On a local
hard disk, it is recommended that you make your hot folder a subfolder of the Jobs folder or Export folder.
Note the following:

• To avoid unnecessary read/write access problems, do not create a hot folder on the desktop.

• Do not select a folder that has been mapped as an internal link.

1 In Server Manager: On the sidebar, click Printers, and select a printer. In the printer's tree view, select a workflow.
On the File tab, expand the Job Detection panel.

2 Under Name, click Choose and browse to the folder that you want to use as a hot folder.

3 Clear Put all incoming jobs on hold (optional).
By default, imported jobs are imported as "hold" jobs to allow you to edit them before printing. Clear this check
box if you want to print jobs automatically on import.

4 Click OK.
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You must now do the following:

• Make sure the hot folder is configured for printer sharing in the operating system. Otherwise, the hot folder
cannot be detected in the network.

• If the hot folder and the Fiery XF server are installed on different computers, make sure that all Windows
computers are configured with the same login credentials, and that all users have administrator rights. You may
need to create a new user on both computers.

For more information, see the operating system's online help, or ask your system administrator.

Create a short cut to the Import folder

If you have configured an EFI VUTEk printer to print to file, you can transfer print files to your printer's Import
folder by creating a shortcut on the Fiery proServer desktop.
1 Move the mouse pointer to the lower-left corner of the screen to see the Windows icon.

2 Right-click the Windows icon, and click File Explorer. Then, right-click This PC, and click Map network drive.

3 Specify the drive letter for the connection and the folder that you want to connect to.

4 Type the location of the shared folder, using the following syntax:
\\Printer_IP_Address\Import\

5 Select Connect using different credentials.

6 Click Finish.
The Windows Security window opens.

7 Type the VUTEk credentials.
Both the user name and the password are vutek01.

8 Select Remember my credentials, and click OK.
Windows sets up a connection to the Import folder, and the mapped drive appears in File Explorer.

9 Click the Windows icon, click File Explorer, and drag the mapped drive to the desktop.
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Import jobs into Job Center

You can import a job by loading it directly into Job Center. If you have previously configured a hot folder, jobs are
automatically imported into Job Center from the hot folder.
1 In Job Center, in the toolbar, click Import.

2 Browse to your job, and click Open.
The Import Files dialog box opens.

3 Click the Add (+) button to import more than one job (optional).
If you import multiple jobs, you can sort the order in which they are listed, by selecting a job and then clicking the
up/down arrows.

4 Select a printer.

5 Select Apply server workflow, and select the custom workflow preset that you created, and a media preset.

6 Select Nest all jobs (optional).
This setting imports all the listed jobs as a nesting. Alternatively, you can create a nesting later in Job Center from
individually imported jobs.

7 Click Hold.
Held jobs are not immediately processed in Command WorkStation. This allows you to make job settings easily.
After job editing, you can start job processing manually.

Jobs are imported into Command WorkStation and listed in Job Center.
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Edit and print jobs

You can apply job-specific settings to a loaded job. Job settings override the default settings from the selected
workflow preset.
The following procedure gives examples of basic job settings. For more information on editing jobs, see the Fiery
Command WorkStation Help.

1 In Job Center: Double-click the job.

2 In Job Editor: Select the job preview.

3 To rotate a job: On the toolbar, under Rotate & Flip, select an angle of rotation

4 To scale a job: Right-click the job, click Scale, click Fit to, and click an item.

5 To align a job on the sheet: On the toolbar, under Align, click a horizontal and vertical alignment type. Under
Margin, type a top, bottom, left, or right margin width.

6 To edit a job label: On the Layout tab, expand the Job Label panel, and click Edit.

7 To edit a nesting: On the Layout tab, expand the Nesting panel.
You can apply uniform page scaling, select an orientation and define the amount of space between nested jobs.

8 To tile a job: On the Layout tab, expand the Tiling panel. In the panel header bar, select the check box to activate
the settings.
You can define uniform or custom tile sizes. You can also display a WYSIWYG preview of one or all tiles by
clicking Tiling Preview on the toolbar. You can save a preview as a PDF file and use it as a guide to help you join
the tiles together after printing.

9 To define spot colors: On the Color tab, expand the Spot Colors panel. In the table's Source column, click the
down arrow next to an unknown spot color, and do one of the following:

• To map the spot color to a color from the internal spot color library: Select a spot color manufacturer, such as
PANTONE, and select a color from the internal spot color library.

• To define color values: Select a color space such as CMYK or L*a*b*, and enter color values in the selected
color space.

10 Click Save.

11 In Job Center: Select the job. On the toolbar, click Print.
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Implement third-party media profiles

You can use a third-party CMYK/OG media profile in Command WorkStation by connecting it to a calibration file.
1 In Job Center: On the toolbar, click Color Tools, and then click Connect Profiles.

2 Under Printer calibration, click Select and browse to the EFI Media Profiles folder.

3 Open the folder for your printer, and then open the subfolder for the media type and resolution that most closely
matches the properties of the third-party media profile.

4 Under Media name, type the name of the media. This is the name that will appear in Command WorkStation.
It is recommended that you type a new media name. If you use an existing media name, the media profile will
have more than one calibration file connected to it, and you will have to select which one to apply in Command
WorkStation.

5 Under Connect to profiles, select Media profile ICC, click Select, and browse to the media profile.

6 Click OK.

The calibration file is saved to the EFI Media Profiles folder.
You can now select the calibration file in Command WorkStation.

Select a third-party media profile in Command WorkStation

When you have connected a third-party media profile to a calibration file, you can select it in Command
WorkStation.
The calibration file must be saved to the correct subfolder of . .\ProgramData\EFI\EFI Media Profiles.

1 In Job Center: Under Media Configuration, click Edit.
The Media Configuration window opens.

2 Under Media name, select the media name that you defined in Color Tools.

3 Under Calibration file, select the calibration file that you selected in Color Tools.
The lists of available calibration files are filtered to display only those that match the selected combination of
media settings.

4 Click Save.
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Install Fiery XF software version 7 on a remote
computer

You can install the Fiery XF software version 7 client component on a Windows or Macintosh computer.
1 Insert the User Software DVD into the DVD drive.

2 Do one of the following:

• Windows: Click Run MasterInstaller.exe.

• Macintosh: Double-click Fiery Master Installer.

3 Follow the on-screen instructions to install the Fiery Command WorkStation Package.
In Windows, you must restart your computer to complete the installation.
The Fiery Command WorkStation icon appears in the taskbar. Command WorkStation starts, and the Welcome
screen is displayed.

You can now connect to the Fiery XF server. For more information, see Log on to server on page 11.
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Finishing options

Command WorkStation can help you trim your media accurately by printing crop marks, Fotoba marks, or grommet
marks. Command WorkStation can also extract cut contours and output directly to an i-cut cutter, a Zünd Cut
Center, or any supported print-and-cut plotter, built-in cutter, or auxiliary cutter.
You require the following options to process certain types of cut marks:

• Cut Marks option: Required for i-cut marks (levels 1 to 5), and EuroSystems OptiSCOUT Design 7 (for SUMMA
F series). Also required to set up a connection to a Zünd Cut Center. The Zünd Cut Center can save more than
one cut path per job.

• Cut Server option: Required to support a wide range of additional cutters and routing tables that are not
supported directly in Command WorkStation.

For more information on installing Cut Server, or setting up an i-cut cutter, Zünd Cut Center, or a supported print-
and-cut device, see the Fiery Command WorkStation Help.
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System backups

Creating regular backups enables you to restore Command WorkStation to an earlier state quickly and easily.
A system backup saves your complete Fiery system, including all user settings, all presets, and all printer
configurations in a single file.

Create a system backup

You can back up your complete Fiery system, including all user settings, all presets, and all printer configurations, in
a single file.
1 In Server Manager: Click Server, click Backup & Restore, and then click Backup.

2 Select the items that you want to include in the backup, in addition to the server configuration.

3 Select the backup location.
By default, the backup is created on the desktop. To choose a different location, click Choose and browse to a
new destination.

4 Click Backup.

Restore a system backup

You can return a Fiery system to a former state by restoring a previously created backup.
1 In Server Manager: Click Server, click Backup & Restore, and then click Restore.

2 Select a backup file from the list.
By default, the list displays backup files that are saved to the desktop. If the backup file is saved elsewhere, click
Choose and browse to that location.

3 Click Restore.

4 Restart the Fiery server.
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Environments

Saving your environments ensures that you use exactly the same settings if you need to output repeat jobs at regular
intervals. You can also use an environment to provide customers with exact workflow/printer information.
An environment saves your printer configuration, including all workflow presets and all media presets, in a single
file. It contains all the information necessary to reproduce the same printer environment on a different Fiery server.

Create an environment

You can save your printer configuration, including all workflow presets and all media presets, in a single file.
1 In Server Manager: On the sidebar, click Printers, right-click a printer name, and then click Save as Environment.

2 Type an environment name (optional).

3 Select the save location.
By default, the environment is saved to the desktop. To choose a different location, click Choose and browse to a
new destination.

4 Click Save.

Restore an environment

You can restore a previously saved environment, consisting of printer configuration, workflow presets and media
presets.
1 In Server Manager: On the sidebar, click Printers. In the Printers tab header, click the Load Environment button.

2 Click Choose, and browse to the environment.

3 Clear the Allow overwriting check box (optional).
By default, existing files of the same name, such as media presets, reference profiles, media profiles and spot color
tables, are overwritten. By clearing this check box, you can retain the existing files.

4 Click Restore.

Each environment has a unique printer connection. If the printer connection already exists, Command WorkStation
restores the environment with placeholder printer information. In this case, you must configure the printer
connection before you can import jobs.
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Backing up Fiery proServer

You can back up the Fiery proServer system, which includes the full operating system and all the data saved to the
hard disk, excluding the output files that reside in the Export folder, due to their size.
Creating a backup of your current Fiery proServer system enables you to restore the system to an earlier state
without having to return it to its factory settings. For more information on backing up and restoring the Fiery
proServer system, see the User Guide.

Note:

It is recommended that you regularly create backups of Command WorkStation in case you need to return the Fiery
proServer to an earlier state. For more information, see Create a system backup on page 24.
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